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Session 1: Source Content 

In the Coloring Book Master Class, we looked at several content resources I go to on a regular 
basis. Now, I want to take a look at some different options like: 

✦ Vintage Coloring Books 

✦ Vintage Design Ornaments  

✦ Patents 

✦ Comic Books 

Most of the coloring book pages I use I find in antique 
stores. Because I like to design my own coloring books 
around themes, these books offer design elements I can 
pull from and add other elements around it to add to a 
themed coloring book. This image (right), for example, is 
scanned from a 1940s coloring book about children’s toys. I 
want to use the wagon.  

Demonstration: Vintage Coloring Books 

Opening the page in Photoshop: 

1. Make a selection of the bear > cut out, filling to white  

2. Because the paper has yellowed over time, I need to fix that: Command/CTL L to bring up 
Levels > select the highlight eyedropper tool and double click to bring up the colors palette. 
Check to make sure this is set to pure white (HEX # ffffff) > click anywhere on the yellow, 
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preferably toward the darker part of the page and it instantly resets the pixels in that color 
and everything lighter than that color to the color I’ve chosen, in this case pure white. Any 
remaining specs of color can be removed by moving the highlight slider to the left 

3. To darken the blacks, we want to do the same 
thing only with the shadow eyedropper set to 
pure black (Hex #000000) > zoom in and click 
on one of the lighter areas of black in the 
wagon > darken further by moving the shadow 
slider to the right.  

4. This is not 100% clean. It isn’t perfect, but it 
isn’t difficult to clean up further using a 
selection tool of choice like the polygonal 
lasso, making a selection around the wagon > 
Command/Control Shift I to invert the selection 
(i.e. choose everything except the wagon) > 
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and fill that to white. 

5. Now, I want to smooth out the lines of the wagon. I have several options: 

(1) Filter > Blur > Gaussian Blur to make everything go out of focus, in this case, about 7 
pixels. Blur is just different degrees of gray, so go back to Levels and use it to re-
sharpen the image by once again resetting what is black and what is white. This isn’t a 
perfect science and depending on where you set the sliders, the amount of lost detail 
can really vary, but it is an option that works well in some situations. 
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(2) Another option which is a far better option is to take the image and turn it into a vector 
image with Adobe Illustrator or online with Vector Magic. Select wagon > copy > open 
Illustrator > paste > image trace. Usually the default settings of Image Trace are pretty 
good but you can control how heavy or light the lines are by adjusting the threshold 
slider. This method definitely helps smooth out the image, it is a lot cleaner, and now I 

can adjust it to any size I want because it is a vector. When I get something I like, I copy 
> take it back to Photoshop > paste. If you think you are going to scale the image, paste 
it as a “smart object.” If you want to use it at the same size, paste as pixels. You can 
see the image in PS is 
now very clean. There 
are a few gaps that were 
in the original image, but 
you can just take a paint 
brush with black paint 
and fix those. 

(3) One additional method 
we can use we will make 
use of more later. In 
Photoshop > Select > 
Color Range and sample 
the black lines. I want to 
select as much of the 
black lines as possible 
so drag “Fuzziness” 
slider to 200 and now 
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the black lines of the wagon are made into 
a selection. Next, open Paths Tab > drop-
down menu on the right (circled below) > 
Make Work Path. You will get a window to 
set a tolerance range. I am going to set it 

to 4. That means that as it create 
the path, it will vary within 4 pixels. 
The higher the number, the less to 
form the path will be. It might 
require a little experimenting. So 
now what it will do is turn the 
image I selected (i.e. the wagon) 
into paths (image right). Click off 
the paths and you have a basic 
outline of the wagon (below). You 
can see it is a little “loosy goosy” 
because I used 4 pixels.  
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Select the path tool > right click anywhere along the path in 
the image above and it will bring up a menu > Fill Path > 
black > and you get the image below. It is a little more 
rugged like a wood cut than the Illustrator version, but there 
may be times you want a look like this. If I had chosen a 
lower number than 4, this might have come out cleaner. Try 
it. 
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Demonstration: Vintage Design Ornaments 

The process is the same as with old coloring books. Our end 
goal is to make these vintage ornaments (example right) 
something we can use for our coloring books. 

1. As before, in Photoshop, Levels > highlight eyedropper set 
to pure white > click on the yellow/tan color in the 
background and shadow eyedropper set to pure black > 
click on the green. You can continue clicking the highlight 
eyedropper in areas of the tan that are still evident, but you 
are going to begin to see it thinning out the lines. 

2. You can see it still has some color casting in the leaves and 
at the edges (image below). We want to get rid of these: 
Image > Adjustments > Desaturate to strip out the color 
(below right) 

3. Zooming in, we can see it isn’t bad, but we need to strengthen the lines. One thing we can 
do is make a copy of desaturated layer > change blend mode of copy from normal to 
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multiply. You can see it instantly starts to darken it up a little bit (bottom). You can do this a 
couple of times to make sure it is nice and clean. 
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4. You can go with the image as it is or convert it to a vector as we did before: Flatten image > 
select all > copy > paste into Illustrator > image trace > adjust threshold slider to get nice 
dark image > select all > copy > paste as a smart object into a new Photoshop document 
the size of our coloring book (8..25 x 10.25 with bleed) > reposition as you like. Zoom in 
and your will see it is very clean with nice, clean lines. 

Page of !39



Advanced Coloring Book Design Tony Laidig

Demonstration: Colorful Pattern 

We can repeat the process with another, more colorful image 
like this one (right). One of the decisions we have to make 
with something like this is what should be black and what 
should be white. Some of these designs will be more difficult 
to convert than others. 

1. We need to darken the image before anything. In 
Photoshop > Levels > pull shadows slider to the right to 
darken and highlight slider left. Adding a little contrast like 
this will make the conversion process easier. 
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2. We could just take this image as we have it into Illustrator let 
the software decide what is black or white. It may or may not 
work. Let’s try… Some are okay and you can play around with 
the threshold slider to change these (right). 

3. Another thing we can do back in Photoshop is to manually set a 
certain color to black or white: with magic wand tool selected > 
set tolerance (menu across the top) to about 50 > select 
something in the color you want to change, say the green > 
Select > Similar. The software will select everything in the 
image that is similar to within 50 pixels of this green color I 
chose. 

4. Create a new layer > fill to black. Repeat with other colors. If 
you see it is selecting too much of a color range (for example, 
you want to select the dark orange and it is also selecting the 
light orange), turn the tolerance down. You can choose some colors to add a layer and fill 
with white and some to fill with black. As you do this to more and more colors, you get an 
image that is closer to what you can use. 

5. Now you will have several layers of black or white, each of which is essentially “covering” a 
particular color. Select any of those layers > right mouse click > blending options > check 
stroke, inside or outside (whichever looks better), of 2 px.  
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6. Right click > Copy layer style > paste layer style onto other layers. At some point, it will be 
“too much” so you just have to experiment with which colors you choose to replace with the 
outlines. It is all going to depend on how much of a particular color is in the original image.  

7. Flatten image > pick one section you like 
> copy > paste into Illustrator and trace > 
copy vector and paste into new 
Photoshop document as a smart object 
so you can scale it up. Now we have this 
hand-drawn look in an image we can use 
(right.) 

There are a lot of these vintage images out 
there in the public domain. They are not 
going to be crisp like images made with 
modern digital tools. But, there are some 
best-selling coloring books out there right 
now which have hand-drawn images, so this 
look is popular. 
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Demonstration: Patents 

To search for patent drawings that you might be able to use in 
making coloring pages, there are some specific keywords that 
you should experiment with. There are 8.5 million patents in 
the public domain and many keywords and combinations of 
keywords you can try in sorting through these; but, whichever 
keywords you want to use, I can get you started in the right 
direction, if you follow these steps closely. 

1. google.com/patents > search “design for wallpaper.” Some 
of the results are not going to be public domain. To narrow 
your search, select search tools > Any time > Filing Date 
and enter From 1800 to 1995 (20 years from 2015) or 
earlier. I like to give myself a little extra buffer, so I am 
going to enter 1990. Now, all the results in the search are 
within that time frame. 

2. You will get a little snapshot of the listing showing what the illustrations look like, if there 
are any. Click on the thumbnail to go to an information page for that patent > click the 
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image(s) thumbnail and you get a larger image that you can copy and take into Photoshop/
Illustrator to create a design. By the way, most of these are repeating images, so if you 
want to create repeating patterns…  

3. Some will be useful and some will not. If you find 
something useful, there is a link at the top of the page 
(left) where you can go to the original, larger image > 
right mouse click > save as to your computer. 

4. Open image in Photoshop > crop to just inside the 
line around the illustration > Image > mode > convert to 
grayscale > image > mode >convert to rgb (You want 
rgb but these are bitmap files and you cannot go directly 
from bitmap to rgb. It requires the two step process.)  
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5. Spend a little time in Photoshop cleaning up the image, painting in lines that are missing, 
etc. > image trace in Illustrator to convert to a vector and you can then use in your art. 

One thing I’ve learned over the years in doing searches for patents is that the keywords to find 
these are not always what you think they should be. Applicants named things silly names to 
make it more difficult for a competitor to find if he was searching for patents. Just be diligent 
and try all kinds of combinations. Think outside the box and your will find a lot of good resource 
material in patents. 

Demonstration: Comic Books 

Comic books work pretty much the same as the colorful pattern image. You bring the image 
into Photoshop and replace colors with white, add a stroke to the layers and create a vector in 
Illustrator.  

1. comicbookplus.com has 17,000 comics in the public 
domain and other things, too. They update regularly so it 
pays to look at the newest additions. They do extensive 
copyright research before they publish these to this site, 
so you can have confidence that all of these are public 
domain > choose image > right click to download > open 
in Photoshop OR 

You can open wholesale in Illustrator and see what you 
get on any and all of these types of assets. You never 
quite know what you will get that way and it can be hit or 
miss if you don’t do some basic “repairs” first, but it is 
always worth a try. For example, a direct image trace of 
this image isn’t perfect, but it holds a lot of the detail.  

2. Copy this Illustrator document 
into Photoshop and change it 
however you want with 
highlights, etc. 
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Software Apps 

I taught several apps in the Coloring Book Master Class and we aren’t going to revisit those 
here, but there are a couple of new apps I’ve been playing around with recently and I want to 
show those to you.  

✦ iOrnament (iPad) is basically a symmetry app, meaning it creates symmetrical designs and 
kaleidoscopes when you move your finger. By default, the canvas is black so I use a white 
pen though as you see, you can choose other colors. Once you choose a pattern from the 
selection on the right, just by drawing with your finger, you get very cool patterns (sample 
below). If you choose another pattern, it instantly turns the drawing into that pattern. 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✦ Kooleido (iPhone) is an iPhone, not iPad app. Exports I’ve done out of this app look pretty 
good on my phone. You can take pictures or take an image from your camera roll (across 
the bottom) to use in the app and when finished, save back to your camera roll and take 
into your computer from there. Selecting button in the top right brings up choices for how 
your image is rendered as you move your finger around. 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✦ Photoshop 

✦ Illustrator 

✦ Corel Painter http://www.painterartist.com/us/ can be an intimidating program. For natural-
media painting, there is nothing better and it has some cool features for creating designs 
for coloring pages. 

Demonstration: Corel Painter 

1. Open Painter > new document > in menu bar, Effects > Esoterica > Make Mosaic and 
Tessellation. 

2. With the Mosaic, just by painting with a paintbrush, you 
can make tiles (menu right). That may or may not be 
useful for you. However, 
under the “Action” drop-down 
menu, the Make Tessellation 
action can be very useful in 
creating coloring pages. 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3. Click anywhere on the canvas and it adds a triangle (right). 
Click again and it adds more detail. Continue clicking to add 
more and more detail (in 3d) in the area where you click 
(below left).  

Click and drag like you are painting, and it adds a lot 
more detail (right). In the “Tile Shape” drop down, you 
can control the shape, say from pieces to cracks and 
spacing, e.g. from even to random. Click the button “Add 
500 points” and it adds 500 geometric points to the 
image (below right). Click again and it adds 500 more 
points to the image. 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Drag a paintbrush through the points and it 
adds more details in the sections you cross.  

NOTE: The fewer lines you have when you 
add points, the larger the open spaces in the 
design will be. One of the effects I’ve liked 
most is starting off with adding points and 
then adding detail by painting across areas of 
the design. You can make this as simple or 
as detailed as you want just by 
experimenting. 

4. Once you are finished, click Apply. It makes 
all the lines white against a black 
background. Obviously, now you can just 
invert this and have black lines on a white 
background for coloring. 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ANOTHER Effect that Painter offers—which I love—is the ability to make mazes. Effects > 
Esoterica > Maze 

You can change the thickness of the lines and seed to get a different look. THE COOL THING 
IS this is not just a maze illustration. It is a legitimate maze. By checking “Display Solution” you 
can see what the real solution is to the maze. Leave this on and make changes and you can 
see how the solution changes. You can control colors of the maze and background, but since 
we are dealing with black/white, it doesn’t really matter. One cool use to these is as 
backgrounds in some of your coloring illustrations. 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Another feature is Blobs. I recommend you use it sparingly. It inserts random blobs on your 
image, in this case, the maze. You can randomize them or control size, etc. Whatever your 
image is, it messes with it.  

You can also just start with 
blank screen instead of an 
image and create random 
blobs on a plain background 
(below). Then, you could just 
select the black blobs, outline 
them (using the stroke tool in 
PS as I showed earlier) and 
have colorable blobs. Notice 
that the blobs get very close 
but do not touch each other. 

Painter has a lot of different kinds of brushes you can 
access in the upper left-hand corner—in pretty much 
any medium known to man—and they can be 
controlled with pressure sensitive tablets. 
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So, here is another great feature in Painter: Choose a pen or brush from the brushes palette > 
in the Menu, Canvas > Symmetry > Kaleidoscope Mode. It creates a canvas in quadrants (you 
can control the number of sections made). As you draw something in one quadrant, it is drawn 
in all the other quadrants simultaneously. You can cross over quadrants and it makes a more 
complex image. You have full control over what you are drawing. 

This is the tiniest fraction of the capability of Painter but it gives you an idea of how powerful 
this software is. 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✦ Filter Forge, https://www.filterforge.com is both a standalone program and a Photoshop 
plugin. There are a number of things you can do with Filter Forge. You can apply filters to 
images but it is also a pattern generator. For easy use, I am going to demonstrate what it 
can do in Photoshop once you have it installed as a Photoshop plugin.  

Demonstration: Filter Forge 

1. Open Photoshop > new document > Filter > Filter Forge. There are a number of patterns 
that are built in, but there are thousands of patterns available for download from the 
website. There are also some presets that come pre-loaded. You can edit the presets and 
save them as new presets. You can also create seamless tiles with these. 

2. Click a preset and you see the settings for that preset. The available settings change 
depending on which pattern you have loaded. Some have a lot of options, some do not. 
Changing any of these settings will completely change the pattern.  
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3. When you are happy with an image, click apply and it will fill your Photoshop canvas with 
that pattern. 

4. So you decide a pattern like this one (left) has too much black for a coloring image. Select 
> color range > eyedropper the black > create new layer > fill to white > right click the new 
layer > blending options > add stroke and now we have a completely colorable page (right). 

You can also switch to a completely different pattern in the Filter Forge Plugin, something like 
this geometric pattern. You may think this orange is not working for you. In settings, it shows 
you what pieces are which colors and you can change these to black and white or any other 
color you want. Change shape, border, etc. and completely change the look of the image. 
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Depending on the kinds of coloring pages you want to create, you can do some really cool and 
very clean designs with this. 

Filter Forge also has many effects you can apply to photographs. Depending on the photo, 
you can get some decent results turning a photo into a coloring page with the software. 

Let’s look at a random, sample image from Pixabay and see 
if we can turn it into a coloring page somehow: 

1. Download and open image in Photoshop 

2. Filter > Filter Forge > choose “Effects” instead of 
Patterns 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3. There are variations in each preset the same as there are in the patterns. You can get a lot 
of cool looks like the image below (right), but it doesn’t work for coloring. 

4. You can download effects from the Filter Forge website the same as you download 
patterns. I’ve downloaded some like Cutline v1.8, Engraving, Pen and Ink Crosshatch, etc. 
StevieJ’s Sketch-Black & StevieJ’s UltraSketch-Black are very interesting. Presets are 
basically various levels of complexity. You can tweak the settings and experiment in getting 
rid of more detail. You have a lot of options for trial and error, but you still may not be able 
to get it to work, depending on the image you use. 
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Trying another image… 

1. I’ve found that if your 
image has a lot of dark 
areas, it can help to 
lighten the image: Image 
> Adjustments > 
Shadows & Highlights > 
default is 35% and often, 
that is enough. 

2. Filter > Filter Forge > it will apply the same setting as 
the last one you used. Using StevieJ’s Sketch-Black, we 
get this image below. It still has some “dirt” along the top 
(see below) but this will clean up for the most part by 
taking it to Illustrator and making a vector image (next 
page). I would probably erase all of the water and could 
erase anything else that I don’t need in making my 
image work. 

NOTE: when it comes to using these large images and these filters, I would recommend that 
you first reduce the images down to the size you need for your final coloring page. So, for 
example, an 8 x 10 coloring page at 300 ppi means you need an image that is 2400 x 3000 (8 
* 300 x 10 * 300). If you need bleed, then add .25 inch to each dimension, e.g. 8.25 * 300 x 
10.25 * 300. 
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✦ Mirror Me, http://www.astutegraphics.com/software/mirrorme/ is an Illustrator plugin that 
takes any vector object and creates a mirror image of it. 

Demonstration: Mirror Me 

1. Illustrator > Window > MirrorMe > MirrorMe 
Panel > draw something; a star. With the Mirror 
Me control panel, you have control over the 
number of axes, which here is set to 8. Click on 
the layer function (circled) and as you move the 
mouse over different points of the star image, it 
shows you the pattern it is generating. 

2. When you see a design you like, click on it and you get an option to apply it to the selection 
or to apply it to the layer. If you apply to the selection, it changes the star to this new 
design. Now, you can move the mouse over this new selection and the resulting image 
becomes more complex. You can keep doing this to get on-going layers of complexity.  
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3. When happy, choose Apply to Layer so it applies the result globally. 

4. Notice the points in the image (below left). The resulting image is a fully editable vector 
graphic (image left) that I created in moments. I can edit one or more individual points. If I 
think the lines are too heavy, I can select all of it and change the stroke weight or anything 
else I can do with an editable vector. If I want to use it as an image and repeat the above 
process with it (image right), I can do that, too. 

You can do this technique with any image you draw or download or photo you take. There is no 
fill in these images. It is nothing but lines and one side is the complete mirror image of the 
other. 
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✦ Symmetry Works, http://artlandia.com/products/SymmetryWorks/ is another Illustrator 
plugin that has a series of patterns it creates based upon whatever vector image you have. 
You can see the selection of patterns across the top of the SymmetryWorks menu. Using 
an image I created in Mirror Me (top right) and applying the kaleidoscope pattern to it, you 
can see it gets pretty crazy pretty fast (bottom right)! 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One thing to remember with Symmetry Works is that the 
original image remains editable but everything else is just a 
reflection. If I change and make a different choice, the 
pattern reflects that choice. Notice the only one highlighted 
is the original. The others are just copies. 

In the “Layouts” list (see menu above), I can choose from 
among different layouts to change how these copies relate 
to the vector image. For example, choosing “Vertical 
gradation”, it makes it look like it is rotated (below). If I now 
apply kaleidoscope pattern to this (right), it gets a little 
confusing, but you get the picture. 
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In your design, you will see a triangle on the original image (below left). This represents the 
slice the program is using to create the pattern. By dragging the corners of it with Illustrator’s 
direct selection tool, you change the shape of the slice on the original and of the copies to get 
a different image (below right). 

If you don’t like it, choose “Release” (the “Make” button becomes “Release” when you have 
made a pattern) and it returns to your original.  

This image above started with a complex shape so the end result got to be very complex as 
well. Doing another sample with a simple shape, you can better see the triangle and how it 
functions to change the image. 

Using a simple ellipse… applying the kaleidoscope pattern we get the image below. Zooming 
in, you can see the triangle. Move the triangle, the shape changes; drag to change the shape 
of the triangle and the shape changes. 
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With a little experimenting, you can get some cool end results. Very quickly, you can create 
symmetrical shapes from a simple element or escalate the design by using a more complex 
shape 
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Just to see the extent of what you can make with this plugin, let’s go to open clipart.org, find an 
image and download the .eps file. Open it in Illustrator (NOTE: sometimes .eps files don’t open 
well, so you can download the .png and trace it instead to create a vector image.) IF the object 
is a grouped object, you need to ungroup (command/control U) it before applying a pattern. 

Applying the kaleidoscope pattern to our butterfly vector, we get the 
image below (left). Choosing other effects, we can get some interesting 
results and the great thing is, it is always editable unlike results you 
would get in Photoshop—one of the big benefits of working with 
Illustrator. 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Session Q & A 

Q: What is a vector? 
A: An image created by mathematical curves instead of pixels, a different expression of how 
the image is represented. The nice thing about vector is that because it is based on 
mathematics and the math doesn’t change regardless of the size, you can blow it up from 
postage stamp to billboard without any loss of quality. And, because the image is defined by 
curves, you can change it at any time by changing the curves. 

Q: In Image Trace in Illustrator, should we click in the box where it says ‘Ignore white?” 
A: You can. I usually don’t. For what I do, it doesn’t really make a difference. 

Q: Is smart object in Photoshop the same as vector graphic in Illustrator? 
A: When you bring a vector into PS as a smart object, you could say that because when you 
want to make changes to it, the object is opened up again in illustrator. If you are just creating 
a smart object created in Photoshop, not by importing a vector, it is not the same as a vector. 

Q: Do you convert to grayscale after you’ve finished doing all the adjustments to it? If not, 
why? I thought they had to be grayscale. 
A: They do not have to be grayscale. If you use grayscale rather than desaturated rgb, the 
blacks will not be as rich in appearance. It is partly to do with who is printing it and how they 
print, but I keep everything rgb. 

Q: Can you explain stroke? 
A: A stroke is an outline, just like tracing around something with a pen. In Photoshop, it is just 
creating an outline around whatever selection you’ve made. 

Q: Are wallpaper patents renewed? 
A: Patents cannot be renewed. Depending on when they were produced, wallpaper patterns 
could be protected by copyright. 

Q: How do you keep track of where you got the images? Do you need to keep track? 
A: If in the public domain, you don’t have to keep track unless you want some organizational 
structure on your own hard drive. 

Q: Repeat the date for patents? 
A: Law says they expire in 20 years for utility patents, 14 for design patents. I just go back an 
extra five years or so. 

Q: Other search terms to use searching for patents? 
A: Lace. Anything related to your theme if you have one. It is just whatever you can think of. 
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Q: Can you use comic strips from old newspapers? 
A: Fair game if in the public domain. 

Q: Is Gimp Shop a good program? 
A: I’m not a fan. It has some cool features and it is free. I use Photoshop and you can get it for 
$10 per month—for the premier imaging program on the planet. 

Q: Can I do image trace in Illustrator CS4? 
A: You should be able to. 

Q: Can you go over preparing final pages to publish a coloring book? 
A: No. I taught it in Coloring Book Master Class and not repeating it here. 

Q: If take non-public-domain photo, turn it into a line drawing and tweak it, does that breach 
copyright? 
A: Yes. 

Q: Can you do things with the images produced by apps like Filter Forge other than filling the 
page with an image? 
A: Yes. You can make repeating patterns, make into shapes, etc. You don’t just have to use as 
a page. 

Q: Have you tried creating an image using iOrnament, Filter Forge, etc. and then loading into 
Pixelmator and apply Kaleidoscope effect? 
A: Definitely. I like to mix and match all the time and use all of these programs back and forth 
like that. 

Q: Any apps that approximate Zentangle effects? 
A: Going to talk about in Session 3. 

Q: If you could choose Photoshop or Illustrator to learn more about, which would you choose? 
A: Illustrator. I am proficient in Photoshop and use it every day. I haven’t used Illustrator as 
much. But, if I was someone who isn’t proficient in either, you can do so many different things 
in Photoshop that it should be the first I would choose. 

Q: Which site can you do mazes with? 
A: What I demonstrated was done with Corel Painter. There is a website that does it, but I’m 
not sure what it is. Try mazegenerator.net. There is an Expert Media Show episode on puzzles, 
etc. and I shared it in that. It is not as comprehensive or nice looking as Painter. 

Q: If I can buy one to start, do you recommend Filter Forge over all the others? 
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A: Yes. It does so much more than just creating coloring book images AND you can use it as 
standalone without Photoshop if you don’t have it. 

Q: Is Illustrator the only program that converts to vector? 
A: It is the best. There is an open source program called Inkscape. I don’t know, but I’ve heard 
it does trace. Corel Draw also does that. There are a couple of web-based solutions and the 
one I can speak to is vectormagic.com. It converts raster to vector with a lot of control for a 
monthly fee. 

Q: Do you have to buy Filter Forge as a standalone OR plugin or can you buy it and use either 
way? 
A: I don’t recall there being a choice one way or the other. I just bought it and was working with 
it as a standalone before I discovered it was installed in my Photoshop. 

Q: Do you mix and match the images in your book, e.g. some florals, some patterns, some 
mandalas, etc. 
A: Some books do that. It is okay BUT what is annoying is if they don’t look similar stylistically. 
In some books, the lines in one are small while the lines in another type are thicker, etc. That is 
like illustrating a children’s book with images 1, 3, 5 looking like charcoal drawings and all the 
rest looking like watercolor. Unless that ties into the story in a specific way, it looks ridiculous. 
Don’t do it. It looks like you slapped something together and those get bad reviews. Make them 
all the same or very similar stylistically and it won’t matter that you mix up designs. 

Q: Is Drag and Drop Illustrator anything like Illustrator? 
A: No. 

Q: What is Filter Forge Librarian? 
A: A download of every filter on their website so you can have access if you don’t have internet 
connection. 
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